
 

 

  

Centre for Instructional Support 
learning@apsc.ubc.ca 

CIS CAPSTONE PROJECT GROUP MAKER 
Documentation 



1 | P a g e  

Contents 

Contents ............................................................................................................................. 1 

I. About .......................................................................................................................... 2 

II. Installation ................................................................................................................. 3 

A. Java Development Kit (JDK) ................................................................................. 3 

B. Program Files ......................................................................................................... 3 

PC ................................................................................................................................ 3 

Mac.............................................................................................................................. 3 

III. Preparing to Use the Program .................................................................................. 3 

C. Creating the Project Database .............................................................................. 3 

D. Creating the Survey on Connect ........................................................................... 4 

E. Exporting the Student Preference Survey Data ................................................... 7 

F. Placing the Database files .................................................................................... 9 

IV. Starting the Program ............................................................................................... 10 

V. Running the Program .............................................................................................. 10 

VI. Uploading the Groups into Connect ....................................................................... 11 

VII. Appendix A: Frequently Asked Questions (FAQs) ............................................. 12 

A. Why is the Program Not Working? ..................................................................... 12 

B. How Long Should I Run For? ............................................................................... 12 

VIII. Appendix B: Troubleshooting .............................................................................. 13 

A. The Program Won’t Start ..................................................................................... 13 

PC .............................................................................................................................. 13 

Mac............................................................................................................................ 13 

B. Error Reading the Project Database ................................................................... 14 

C. Error Reading the Student Preferences .............................................................. 14 

D. The Program Didn’t Place All Students .............................................................. 14 

IX. Appendix C: Editing the Source Files [CIS Staff Only] .......................................... 15 

 



2 | P a g e  

I. About 

The algorithm for the CIS Capstone Project Group Maker is heavily based off of an 

algorithm that was published in 2007 by two professors from the University of Calgary. It 

can be viewed in more detail by downloading it from the following link: 

 https://peer.asee.org/an-algorithm-for-project-assignment-in-capstone-design.pdf 

The program begins by assigning students in a random order to their first choice of 

project. If their first choice is not available, they will be placed in their second choice. If 

their second choice is not available, they will be placed in their third choice, etc. Students 

who are not able to be placed in any of their chosen projects (the projects are all full) will 

be placed in a group of unassigned students. 

Any projects that are too small after the initial placement will be removed, unless 

removing that project would take the total number of available spots in projects below 

the total number of students. 

The program then chooses a random student from the group of unassigned students 

and places them in their first choice of project. At the same time, a random student is 

removed from that same project and an attempt is made to place them in another one of 

their ranked projects. If this removed student is able to be placed in another one of their 

ranked projects, they will be placed in this project and all changes will be made 

permanent. If the newly removed student is not able to be placed in one of their ranked 

projects, they will be placed in their first choice of project and a new student will be 

removed from that project and undergo the same routine. This bumping routine will go 

up to 5 “bumps” deep at which time all the changes will be undone and the original 

unplaced student will remain unplaced. This bumping routine will be performed for every 

student in the group of temporarily unassigned students. 

The program then assigns a numerical score to the groups that were created. Again, 

the method for calculating this numerical value can be viewed in more detail in the original 

document at the link above. If these groups have a higher numerical score than the 

highest score that was previously achieved, these groups will become the new highest 

score and the groups will be saved. 

The program will then shuffle the students in a random order and attempt this 

procedure again. The program will end when the desired number of minutes is reached 

or the maximum number of iterations is reached (1 billion). The groups that had the 

highest overall numerical score assigned to them will be written by the program into two 

Excel files: one for general viewing and another for uploading the groups to Connect. 

https://peer.asee.org/an-algorithm-for-project-assignment-in-capstone-design.pdf
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II. Installation 

A. Java Development Kit (JDK) 

In order to run the program, you need to download the Java Development Kit (JDK): 

 http://www.oracle.com/technetwork/java/javase/downloads/index.html 

B. Program Files 

You will download the program files from the Centre for Instructional Support’s 

website (http://cis.apsc.ubc.ca/capstone-project-groups/). This will provide you with a 

zipped folder. 

PC 

To obtain the folder containing the files, right-click on the zipped folder and click 

“Extract All.” Then, “Browse…” for the location that you want the folder placed and click 

“Extract.” The title of the new folder containing the program’s file will be the same as that 

of the zipped folder. 

Mac 

To obtain the folder containing the files, double-click on the zipped folder. The folder 

containing the files should be automatically extracted and placed in the same location as 

the zipped folder. The title of the new folder will be the same as that of the zipped folder. 

III. Preparing to Use the Program 

A. Creating the Project Database 

1. Create a new Excel spreadsheet. 

2. In the first row, add the titles “Project Number”, “Minimum Group Size”, “Maximum 

Group Size”, “Title”, and “Description”, from left to right, respectively. 

3. Enter the information for the projects into the spreadsheet. Make sure that none 

of the five cells are empty for any given project. 

o Project Number,” “Minimum Group Size,” and “Maximum Group Size” must 

have numerical cells (correct: “4”; incorrect: “four”, “project4”, etc.). 

o “Title” and “Description” must have string cells (correct: “four”, “project4”, 

etc.; incorrect: “4”). 

http://www.oracle.com/technetwork/java/javase/downloads/index.html
http://cis.apsc.ubc.ca/capstone-project-groups/
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4. Save the spreadsheet as an “Excel Workbook.” This file will be your Project 

Database. 

 

B. Creating the Survey on Connect 

1. Go to the Content Area where you wish to place the Survey. 

2. Hover your mouse over the “Assessments” tab on the top of the Content Area. 

When the drop-down list appears, select “Test.” 
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3. Click “Create” to create a new Test. Enter your desired information and click 

“Submit.” The Test Canvas will open. 

4. Hover your mouse over the “Create Question” tab at the top of the Test Canvas. 

When the drop-down list appears, select “Jumbled Sentence.” 

 

5. In the “Question Text” box, enter a prompt for the student’s first choice of project 

followed by “[a]” (e.g., “1st choice of Project: [a]”). The “[a]” will become a drop 

down list consisting of the possible responses when the question is given to the 

students. Therefore, let’s create those responses. 
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6. Scroll down to the “Answers” section. Set the “Number of Answers” equal to the 

number of projects that the students will choose from. Then, in the box next to 

“Answer 1” enter the number of the first project and so forth until all the answer 

boxes are filled. 

7. Click “Next” and then “Submit and Create Another” to create a question for the 

students’ second choices, third choices, etc. such that you create n questions so 

that the students can rank their top n projects. 

 

8. After you have finished the last question, click “Submit” rather than “Submit and 

Create Another.” 

9. Change the points for each question to 0 as found at the top right of each of the 

questions in the Test Canvas. 
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10. Click “OK” at the bottom right of the page. 

11. Click “Submit.” 

12. Enter preferred settings (make sure you “Make the link available”) and click 

“Submit.” 

 

C. Exporting the Student Preference Survey Data 

1. After the students have completed the survey (though it is technically a test), 

navigate to the “Full Grade Center” under “Grade Center” on the left Course Menu. 
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2. Find the column which represents the survey (it will have the same name). 

3. Select the grey chevron to the right of the column title to open the contextual menu 

for the column. 

4. Select “Download Results.” 

 

5. Select “Click to download results.” 

6. Open the download. 

7. If prompted for which program you want to open this file with, select “Excel” or 

“Excel (desktop).” 
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8. Save this file as an “Excel Workbook.” This will be your Student Preferences 

Database. 

 

D. Placing the Database files 

1. Copy your Project Database and Student Preference Database Excel files. 

2. Open the “CIS Capstone Project Group Maker” folder.  

3. Open the “Files” folder. This is the location to paste your Project Database and 

Student Preference Database Excel files. 
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IV. Starting the Program 

1. Open the “CIS Capstone Project Group Maker” folder. 

2. Click on “Make Groups!” to start the program. The program should open in the 

Command Prompt (PC) or Terminal (Mac). 

Note for Mac Users: If you receive a message that the program cannot open because it is 

from an “Unrecognized Developer”, simply right-click on “Make Groups!” and click “Open” 

and then “Open” again to start the program. 

V. Running the Program 

The program will ask you three questions when you start it and one question at the 

end: 

1. What is the name of your Project Database? 

2. What is the name of your Student Preferences Database? 

3. How many minutes do you want the program to run? 

4. Do you want to run the program again? 

The first two questions are straightforward, simply type the name of your 

corresponding Excel files which you placed in the “Files” folder. The third question is a 

little trickier; typically 1–5 minutes should be more than enough time (see How Long 

Should I Run For?). After answering these questions, as long as there were no errors (if 

so, see Appendix B: Troubleshooting), the program will begin making groups for as many 

minutes as were specified. 

The program will immediately print out on the console any students who placed at 

least one project multiple times in their rankings. Since these students were likely trying 

to beat the system, they will not be included in the groups and can be manually placed 

into groups afterwards. 

After the program has run for the specified time, it will print out a message informing 

the user of the results of the program’s efforts. The user will be informed if the program 

was able to place every student in a group. If it wasn’t, the unplaced students will be put 

into a project with the number “N/A.” If you don’t know why some students are not placed 

in a group, see The Program Didn’t Place All Students. 

The program will then prompt the user for a file name which will be given to the two 

Excel spreadsheets containing the group information. These will be written by the 

program and placed in the “Files” folder. The first Excel spreadsheet (titled 

“YourSpecifiedFileName”) is for general viewing purposes and will have the exact name 
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that is entered. The second Excel spreadsheet (titled “YourSpecifiedFileName (Connect 

Upload)”) is for uploading the groups into Connect. 

Finally, the program will ask the user if they want to run the program again. If so, it will 

prompt the user for the third question again (it assumes the same Project Database and 

Student Preference files). If not, the program prints a goodbye message and terminates. 

VI. Uploading the Groups into Connect 

1. Open the created Excel file for uploading to Connect (appended with “(Connect 

Upload)”) and save it again as a “CSV (Comma delimited)” file. If you encounter 

any error messages, click “Yes.” 

 

2. Once the file is saved in the CSV format, go to the Connect page of the course. 

Navigate to “GroupBuilder” under “Course Tools.” If “GroupBuilder” is not available 

under course tools click below on “Customization” and then “Tool Availability.” 

Find “GroupBuilder” and click the farthest leftward box possible. Click “Submit” 

and navigate to “GroupBuilder” under “Course Tools.” 
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3. Select “CSV Import.” 

4. Select “Browse My Computer,” and then find and select the CSV file that you just 

saved. 

5. Click “Submit.” Your groups should be created in Connect. 

VII. Appendix A: Frequently Asked Questions (FAQs) 

A. Why is the Program Not Working? 

See Troubleshooting. 

B. How Long Should I Run For? 

In reality, 30 seconds would be a fine amount of time to get groups for almost all 

scenarios. Obviously, the larger the size of the class, the more variables that are present 

and so a longer time is preferable to give the program more opportunity. Also, we will 

want to stay on the safe side and make sure we aren’t providing too little time. You can 

experiment with different time frames to see how much improvement you get for an 

additional period of time. 

The following data shows the quality of the groups as a function of the number of 

iterations for a class of ≈200 students with one minute of runtime on a standard laptop. 

As we can calculate, by the end of the first minute, the slope of the function decreases to 

+0.00000002125/iteration. Therefore, it would take around 470,000 iterations (≈ 5 min.) 

to increase the Normalized Satisfaction Score by 0.01. It should, therefore, be more than 
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enough to limit the search time to 1–5 min. to obtain groups which are very close to 

ideal. 

 

VIII. Appendix B: Troubleshooting 

A. The Program Won’t Start 

If, after clicking on “Make Groups!” the program does not start or encounters an error 

the first thing you should do is make sure that you have downloaded the latest version of 

Java. If you have installed the latest JDK, you can attempt to start the program via the 

Command Prompt (PC) or Terminal (Mac). If the instructions below don’t work, double-

check that you have java downloaded properly. 

PC 

1. Open “Command Prompt.” 

2. Navigate to the location of the “CIS Capstone Project Group Maker (PC)” folder. 

Basic navigation commands can be found at this link:   

a. http://www.digitalcitizen.life/command-prompt-how-use-basic-

commands 

3. Type “cd CIS Capstone Project Group Maker (PC)” and hit enter. 

4. Type “cd Files” and hit enter. 

5. Type “java –jar GroupMaker.jar” and hit enter. The program should start. 

Mac 

1. Open “Terminal.” 

http://www.digitalcitizen.life/command-prompt-how-use-basic-commands
http://www.digitalcitizen.life/command-prompt-how-use-basic-commands
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2. Navigate to the location of the “CIS Capstone Project Group Maker (Mac)” folder. 

Basic Navigation commands can be found at this link: 

a. https://github.com/0nn0/terminal-mac-cheatsheet/wiki/Terminal-

Cheatsheet-for-Mac-(-basics-) 

3. Type “ cd “CIS Capstone Project Group Maker (Mac)” ” and hit enter. 

4. Type “cd Files” and hit enter. 

5. Type “java –jar GroupMaker.jar” and hit enter. The program should start. 

B. Error Reading the Project Database 

If an error is encountered while reading the Project Database Excel file, double-check 

the following: 

 The name of the file was entered correctly. 

 Every cell of every project in the Project Database is not empty. 

 Project Database contains the correct cell-types. First three columns should be 

numeric and last two columns should be string-type cells. 

 View the “Project Database” in the “Example Files” folder and compare it to yours. 

C. Error Reading the Student Preferences 

If an error is encountered while reading the Student Preferences Excel file, double-

check the following: 

 The name of the file was entered correctly. 

 Check that your Student Preferences Excel file is identical in format to an Example 

Student Preferences Excel file located in the “Example Files” folder (within the “CIS 

Capstone Project Group Maker”). 

o If it does not match, check that the test on Connect was created correctly. 

 View a Student Preferences file in the “Example Files” folder and compare it to 

yours. 

D. The Program Didn’t Place All Students 

If the program does not make groups with 100% student placement (i.e. no students 

without a group) and you gave it sufficient time to run (1–5 mins.), then your parameters 

in the Project Database Excel file are too restrictive. Try lowering the minimum group 

sizes and raising the maximum group sizes in the Project Database Excel file to attempt 

to provide the program with more flexibility in making the groups. Ensure that you alter 

https://github.com/0nn0/terminal-mac-cheatsheet/wiki/Terminal-Cheatsheet-for-Mac-(-basics-)
https://github.com/0nn0/terminal-mac-cheatsheet/wiki/Terminal-Cheatsheet-for-Mac-(-basics-)


15 | P a g e  

not only the original Project Database file in your documents but also the copy of it that 

the program is reading. 

IX. Appendix C: Editing the Source Files [CIS Staff Only] 

*PLEASE ONLY EDIT THE SOURCE CODE IF YOU ARE CONFIDENT IN YOUR ABILITIES* 

If there is a serious error in the program which needs a solution, the source files are 

included in the “Source Files” folder. I used Eclipse as my IDE while writing the program; 

Eclipse can be downloaded at the following link: 

 https://eclipse.org/downloads/ 

The files for the program are contained within the “CIS Capstone Project Group Maker” 

on the shared drive (00_COOP-Student Projects -> Andrew (Jan. 2016 – Apr. 2016) -> 

Group Maker Program. 

To open the source files in Eclipse, move the folder titled “CIS Capstone Project Group 

Maker” from inside the “Source Files” folder into your “workspace” folder. Then, in Eclipse, 

click File -> Import -> General -> Existing Projects into Workspace -> Next. Then select 

“Browse…” to the right of the “Select root directory:” box. Navigate to your “workspace” 

and select the “CIS Capstone Project Group Maker” folder and click “OK.” Then, click 

“Finish” and the files should be editable via. Eclipse. 

If a lot of error messages appear, you probably need to add the Apache POI library to 

the build path. To do this click Project -> Properties -> Java Build Path -> Libraries -> Add 

External JARs…. Then, open all the executable JAR files within the “poi-3.13” folder. Click 

“OK.” Any error messages should now disappear. 

Once you are finished making the relevant changes to the source code, click File -> 

Export -> Java -> Runnable JAR file -> Next. First, change “Launch configuration” to the 

Main which contains “CIS Capstone Project Group Maker.” Then, click “Browse…,”choose 

an easy to find location, and choose “GroupMaker” as the “File name;” click “Save.” Ensure 

that “Extract required libraries into generated JAR” is selected under “Library handling.” 

You can then click “Finish.”  

Find the created executable JAR file and replace the file with the same name in both 

the PC and Mac versions of the program files. Ensure that the new JAR file has the same 

name as the old JAR files. Next, copy the new source files into the “Source Files” folder. 

Then, update the documentation with the relevant changes and replace the old 

documentation in both the PC and Mac versions of the program. Finally, compress the 

folders and update the program files on Dropbox (see the Credentials.txt file for login 

information). 

https://eclipse.org/downloads/
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Last Updated: April 29, 2016 at 9:30 PST. 
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